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1. Background
In recent years there has been an increase in the number of smartphones and tablets. This change
has not only brought new types of applications and programming philosophy to meet the new needs
of the population, but it has also pushed the development of embedded processors. Users demand
relatively high computational power with a low energy consumption maintain a long battery life.

ARM processors now dominate the mobile phone space due to their lower power requirements with
98% of mobile phones having an ARM processor [Roberts-Hoffman 2009], and is expanding its
market in set-top boxes ans smart TVs. ARM processors dominate these markets because they are
more efficient than their x86 counterparts and have a very competitive price. 

It should also be noted that, at the moment, ARM processors cannot achieve the performance levels
of some x86 systems, which still have the majority of the market share in laptops, desktops and
servers.

The  following  graph,  extracted  from  [Ou  2012],  compares  the  power  efficiency  with  CPU
utilization of a ARM A9 cluster and an Intel dual core x86 workstation for web server application at
different file sizes.

Figure 1-1:  Energy-efficiency vs. CPU Utilization Level [Ou 2012]

With CPU utilization higher than 20%, the ARM A9 processor presents an advantage in efficiency
over Intel processor.
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The following graph, extracted from [Blem 2013], compares power consumption with performance
of 2 ARM processors and 2 Intel x86 processors.

Figure 1-2:  Power Performance Trade-offs [Blem 2013]

Regardless  of  ISA or  energy-efficiency,  high-performance  processors  require  more  power  than
lower- performance processors. They follow well established cubic power/performance trade-offs
[Blem 2013].

The previous graphs suggest that if the task a computer must perform is not CPU intensive and/or
can be subdivided into smaller tasks to run concurrently, it is advantageous, from the point of view
of efficiency, to use an ARM based distributed system or cluster.

This hypothesis has been analysed in various studies in recent years. [Ou 2012] and [Vidal 2012]
both conclude that ARM based clusters for server applications (web and web, file and database
respectively) is a viable and power efficient solution. Likewise, [Abdurachmanov 2014] concludes
that an ARM based cluster is a viable and power efficient solution for scientific computation at the
CERN.

The results  of the aforementioned studies suggest that the use of ARM processors in industrial
computers  could  also  be  advantageous.  It  is  worth  noting  that  ARM  processors  are  not  only
efficient,  but  there  are  cost-effective  solutions  on  the  market.  A good  example  of  this  is  the
BeagleBone Black, a 45$ community-supported development platform with 512MB of RAM, TI
AM3359 1.0GHz processor and a power consumption <2W.

The  disadvantage  that  ARM  based  systems  present  versus  x86  industrial  PCs  is  binary
incompatibility, x86 systems are well established and have been the standard for many years. Much
software has been developed for these systems, most of which can not be easily ported to the ARM
architecture due to copyright reasons and/or framework incompatibility.

By developing cross-platform applications, it is possible to use ARM based systems as industrial
computes  and benefit  from the  advantages  of  this  platform over  traditional  x86 systems while
developing applications that can easily be ported to said systems. Therefore, this work does not only
present the implementation of an application for an industrial scale for an ARM development board,
but it is also intended to serve as reference on how to develop cross-platform application for ARM
embedded Linux systems that x86 computers can also benefit from. 

By developing cross platform applications, the hardware and OS range of possibilities becomes
larger and a more optimal solution can be found for a given problem.
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2. Factors to Consider
2.1 Initial Specifications

• Touchscreen  graphical  open  source  application  for  an  industrial  scale  using  the  Qt
framework.

• Texas Instruments Sitara AM335x processor running Linux.

• System shall  receive  the  output  of  a  Microgram IE21  industrial  scale  from Microgram
Instruments Española S.A. industrial scale over RS-232.

• Simple  and  intuitive  software,  such  that  the  users  are  able  to  deduce  how  to  use  the
application without any prior knowledge or help.

• The scale is intended to weigh fruit and vegetables, but the database should be generic such
that it can be used for commerce of other goods by weight. The image, name, index, price
and accumulated sales shall be stored in a relational database.

• The Application must automatically update the GUI when a product is added, removed or
updated in the database.

• The system shall  be  network  connected  and have  a  fixed  IP address  assigned  for  easy
maintenance and database access.

• Critical errors and non-critical errors should be handled differently. The application should
exit immediately when a critical error is encountered. A warning system is allowed for non-
critical errors.

• The application shall launch on system boot.

• The application shall have a system shutdown and system restart under the advanced options
menu.

• The application shall be as modular as possible for simplicity and source code reuse.

• A low-cost and low-power solution should be favoured as the adopted solution.

• The application shall be cross-platform, developed under a framework which allows for the
code  to  be  easily  compiled  to  run  on  different  processor  architectures  and  operational
system.
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2.2 Needs Study

The system is requires to have a touchscreen graphical user interface. The hardware platform should
either come with such screen or have the possibility of adding one via off-the-shelf products via
additional I/O such as GPIOs and/or HDMI + USB or any combination of these or any other valid
media interface (VGA, DVI, etc.). In any case, the hardware platform must have the I/O capability
for the selected screen. It is worth noting that the touchscreen can be a generic screen or one made
specifically for the hardware platform. An example of the later are the many third party BeagleBone
LCD “capes” for the Texas Instruments BeagleBone Black.

The system is also required to interface with an industrial scale over RS-232. Modern embedded
systems are likely to not have a RS-232 ±15V DB-9 (or DB-25) port present, therefore, a USB-to-
serial adapter shall be used in this project. This implies that the hardware platform must have at
least 1 available USB (host) port. As the data transfer rates of RS-232 is much smaller than that of
the USB protocol, a USB 1.1 or USB 2.0 port is sufficient. A USB 3.0 or USB 3.1 port is not
required.

As the system is required to have a static IP address for easy database management and system
maintenance,  it  is  implied  that  the  hardware  platform must  have  at  least  1  Ethernet  Port.  The
purpose of this port is to establish an SSH or SFTP. For the expected loads, high data transfer rate is
not required and therefore,  a Gigagit  Ethernet port  is  not required.  A 100Mb/s Ethernet port  is
sufficient.

The software shall be designed to be cross-platform from the standpoint of the operating system and
the hardware architecture. The application shall have a “native appearance” on all the platforms it is
executed.

Finally, for the development of the application, the use of open source tools, libraries and compilers
shall be favoured over closed source alternatives as they, amongst other advantages, improves the
maintainability of the software and it grants independence from the supplier. It is worth noting that
the use of open source tools in the development and documentation of the project are also favoured
because of the client's and the author's philosophy.
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3. Alternative Solutions
3.1 Alternatives for the Hardware

In this section, some of the most popular single-board ARM computers that are Linux capable shall
be compared.

Raspberry Pi B A10-OLinuXino BeagleBone Black ODROID-U3 Cubieboard 2

Processor ARM11 700MHz Cortex-A8 1GHz Cortex-A8 1GHz Cortex-A9 Quad 1.7GHz Cortex-A7 Dual 1GHz

GPU Video Core IV Mali-400 SGX530 Mali-400 Mali-400

RAM 512MB 512MB 512MB 2GB 1GB

Flash 0MB 0MB 2GB 0MB 4GB

USB 2 2 host + 1 OTG 1 host + 1 OTG 3 host + 1 OTG 2 host + 1 OTG

Ethernet 1×10/100M 1×10/100M 1×10/100M 1×10/100M 1×10/100M

WiFi ✗ ✗ ✗ ✗ ✗

Bluetooth ✗ ✗ ✗ ✗ ✗

SATA ✗ ✓ ✗ ✗ ✓

GPIO 17 160 65 Expansion 96

SPI ✓ ✓ ✓ Expansion ✓

I2C ✓ ✓ ✓ Expansion ✓

Price $35 USD 30€ (≈ $41 USD) $45 USD $59 USD $65 USD

Comment Large Community Large Community

ODROID-U3 offers the best  value,  but  it  is  clear  that with its  specifications and lack of stock
GPIOs it is intended as a lightweight workstation. Nevertheless, it can be considered for industrial
computer applications. 

On the other hand, the ODROID-U3 is overpowered for the application described in this work. The
BeagleBone Black or the  A10-OLinuXino are better  suited for the intended application in  this
sense.

Out of the two previously mentioned development boards, the BeagleBone Black is considered the
best  solution  for  the  intended  application.  Despite  the  BeagleBone  Black  having  slightly  less
features than the ODROID-U3, it has a larger community and more support, which should not be
overlooked  when  choosing  a  hardware  platform as  it  can  reduce  development  times  and  ease
operating system and package support. 
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It  should be noted that the  BeagleBone Black is  considered the best hardware solution for this
project, the application shall be develop on a Texas Instruments TMDSSK3358 AM335x Starter
Kit, as this board was physically available for use at the Universitat Politècnica de València at the
time of writing.

The Texas Instruments TMDSSK3358 AM335x Starter Kit has more features overall  and has a
higher price, but the BeagleBone Black and the TMDSSK3358 AM335x Starter Kit both have an
AM335x processor, and therefore, the procedures to develop applications and the resulting binaries
are the same in both platforms.

Figure 3.1-1: Major Functional Blocks of the TMDSSK3358

3.2 Alternatives for the Programming Language

There  are  a  lot  options  for  selecting  a  programming  language,  but  this  section  will  focus  on
comparing three of the most popular and predominant languages used to develop cross-platform
applications.

3.2.1 Java

Pros
• Simple and powerful.

• Very popular.

Cons
• Slower than low level languages.

• Less efficient than native compiled languages.

• Many vulnerabilities.

• Requires a virtual machine.
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Java  applications  run  on  top  of  virtual  machines,  which  makes  them slower  and  much  more
resource hungry than native compiled languages.  Aside from efficiency, there are many security
risks involved in using Java’s virtual environment. Because of the aforementioned reasons, Java has
not been considered an appropriate solution for this project, although it is a valuable option.

The rise of the android operating system in recent years is a good example of the potential of Java
for the industry as the are a wide rage of hardware architectures running Android and they all use
the same package system and binaries, which may simplify the maintainability and distribution of
applications.

3.2.2 Python

Pros
• Simple.

• Very popular.

Cons
• Slower than low level languages.

• Less efficient than native compiled languages.

• Prone to errors at development stage.

Python is currently a very popular language that has a large community, but it was designed to be
used as a scripting language,  which inherently makes it  much slower than compiled languages.
Also, being an interpreted language, many common error, which would otherwise be detected at
compile time, are not detected until the application is run and debugged, this makes development
times longer for large applications. Because of the aforementioned reasons, like Java,  Python has
not been considered an appropriate solution for this project, but is also a valuable option.

3.2.3 C++ 

Pros
• Very efficient.

• Many libraries.

Cons
• Applications  compiled  for  a  specific

architecture and operating system.

• Complex syntax

C++ is widely accepted in the field of programming, and given the amount of documentation and
the efficiency of the resulting applications, C++ is a good alternative with which to develop the
application described in this work. There are interesting frameworks on top of C++ such as GTK,
wxWidgets, Qt, etc. that may be used for the development of the application.

With the C++ Qt framework it is possible to develop cross-platform applications that can easily
compiled to target various architectures and operating systems without modification of the source
code. Specifically, there is a branch of the framework intended for Embedded Linux. This branch
allows to create graphical applications that use a virtual frame buffer. The application itself provides
the frame buffer, and a Qt application for embedded Linux is already running, other applications
will  connect  to  the  first  application's  frame buffer,  This  saves  on memory usage and does  not
require a fully fledged X11 server to be running on the target system.
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3.3 Alternatives for the SQL Based Database Engine

There  are  a  lot  good  options  for  selecting  a  database  engine,  but  this  section  will  focus  on
comparing three of the most popular and predominant database engines.

3.3.1 MySQL / MariaDB

Pros
• Scalable.

• Good performance features.

• Supports user permission.

• Good for client-server applications.

• Good with multi-master replication.

Cons
• Complex set-up.

• Requires server.

MySQL is popular in medium-to-high size systems. It has a large community and there are many
open source project developed with this database system, which makes it relatively easy to set up
and borrow code from these applications to reduce development time. On the other hand, set-up
more complex than other database system and there are limitation when using it in large systems or
when data accuracy is extremely important. It is intended for systems larger than the application to
be developed.  Because of the aforementioned reasons, MySQL is not considered and appropriate
solution for this project.

It is worth noting that MySQL and MariaDB are not the same database engine, but they are closely
related, as they both have the same initial author. MariaDB is as a community-developed fork of
MySQL.

The goal for Maria-DB is to be a drop-in replacement for MySQL – with more features and better
performance.  MariaDB  is  based  on  the  corresponding  version  of  MySQL,  if  one  exists.  For
example,  MariaDB 5.1.53  is  based  on  MySQL 5.1.53,  with  some  added  bug  fixes,  additional
storage engines, new features, and performance improvements. [Bartholomew 2013]

3.3.2 PostgreSQL

Pros
• Scalable.

• Many performance features.

• Supports user permissions.

• Conforms with SQL standard

• Conforms with ACID standard

• Easily portable to Oracle SQL.

Cons
• Complex set-up.

• Requires server.

• Smaller community.
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PostgreSQL is slower than other database engines such as MySQL, but it is much more feature-rich.
It also conforms with the SQL standard and is specially appropriate if there is a possibility of later
moving to Oracle DB or many other closed source database systems, as for the most part, code
which runs PostgreSQL will run on these systems. On the other hand, it is harder to set up, there is
less  documentation  and it  has  a  smaller  community.  It  is  intended for  systems larger  than  the
application to be developed. Because of the aforementioned reasons, PostgreSQL is not considered
and appropriate solution for this project.

3.3.3 SQLite

Pros
• Fast set-up.

• Rapid development.

• Good for embedding.

• Single file database.

• Easy backup.

• Many supported programming languages.

• Low overhead.

• Fast read operations.

Cons
• Not many performance features.

• Slow write operations.

• Does not scale well.

• Does not have user management.

• Not appropriate for large databases.

• Not appropriate for high concurrency,

SQLite was not designed to compete with MySQL, PostgreSQL or Oracle DB. Although it can be
used, for example, on websites that do not have a very high traffic (<10  hits/day), but it excels in⁶
embedding small databases into application. Due to it's efficiency, ease of use and low maintenance,
this server-less single-file database seems the best alternative with which to develop the application
described in this  work,  as it  is  one of the situations it  was designed for.  Moreover,  due to the
characteristics of the applications to be developed, none of the disadvantages of this database file
suppose a limitation. 

According to [Allen 2010],  “One advantage of having a database server inside your program is
that no network configuration or administration is required. [...] no firewalls or address resolution
to worry about, and no time wasted on managing intricate permissions and privileges. Both client
and server  run together  in  the  same  process.  This  reduces  overhead related  to  network  calls,
simplifies database administration, and makes it easier to deploy your application. Everything you
need is compiled right into your program”.
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4. Development Environment Set-up
This section is a reference on how to set up a development environment to develop and debug Qt
applications  targeted  to  AM335x  processors.  Texas  Instruments  (TI)  provides  an  SDK  with
everything necessary to develop Qt applications for this target.

4.1. Host Computer

Development must be done on a x86 Linux computer. TI strongly recommends to install the SDK
and develop on an Ubuntu LTS release as this is the environment that was used to develop and test
the SDK, but please note that this is a suggestion and it does not prevent the SDK from installing on
other Linux distributions.

4.1.1 Installing TI SDK

First, the latest SDK from TI must be downloaded. At the time of writing, the newest version was
6.00.00.00.

user@debian:~$ cd Downloads/ 

user@debian:~/Downloads$ wget 
downloads.ti.com/sitara_linux/esd/AM335xSDK/latest/exports//ti
sdkam335xevm06.00.00.00Linuxx86Install.bin

Once the download is complete, the binary must be made executable.

user@debian:~/Downloads$ chmod +x tisdkam335xevm06.00.00.00
Linuxx86Install.bin

Now a directory, owned by the current user,  shall be created for the installation of the SDK.

user@debian:~/Downloads$ sudo mkdir /opt/tisdkam335xevm
06.00.00.00/ 

user@debian:~/Downloads$ sudo chown $USER /opt/tisdkam335x
evm06.00.00.00/

Finally the installation process can be started.

user@debian:~/Downloads$ ./tisdkam335xevm06.00.00.00Linux
x86Install.bin 

Note  that  when  the  asked  for  the  installation  directory,  the  previously  created  directory  was
selected.
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4.1.2 Installing Qt IDE

First, the latest Qt Installer must be downloaded. At the time of writing, the newest version was Qt
5.2.0 with Qt creator 3.0.0.

user@debian:~$ cd ~/Downloads 

user@debian:~/Downloads$ wget download.qt
project.org/official_releases/qt/5.2/5.2.0/qtlinux
opensource5.2.0x86_64offline.run 

Once the download is complete, the binary must be made executable.

user@debian:~/Downloads$ chmod +x qtlinuxopensource5.2.0
x86_64offline.run 

Now a directory, owned by the current user,  shall be created for the installation of the IDE.

user@debian:~/Downloads$ sudo mkdir /opt/Qt5.2.0/ 

user@debian:~/Downloads$ sudo chown $USER /opt/Qt5.2.0/ 

Finally the installation process can be started.

user@debian:~/Downloads$ ./qtlinuxopensource5.2.0x86_64
offline.run

Note  that  when  the  asked  for  the  installation  directory,  the  previously  created  directory  was
selected.

To be able to develop with the SDK, there are shell  variables that must be set.  TI provides an
environment set-up file to automate this task. To ease this task further, a start-up script that sources
the environment set-up file before launching Qt creator can be used.

user@debian:~$ nano /opt/Qt5.2.0/launchsitara.sh

The content of the script being:

#!/bin/bash
source /opt/ti-sdk-am335x-evm-06.00.00.00/linux-devkit/environment-setup
/opt/Qt-5.2.0/Tools/QtCreator/bin/qtcreator
exit 0

To make the script executable:

user@debian:~$ chmod +x /opt/Qt5.2.0/launchsitara.sh

From now on, when starting Qt creator to develop for an AM335x target, the following command
shall be executed.

user@debian:~$ /opt/Qt5.2.0/launchsitara.sh
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4.1.3 Configuring Qt kit for AM335x

The  following  section  is  a  commented  extract,  with  slight  modifications  of  part  of  the  Texas
Instruments Document: AMSDK Linux User's Guide, [TI-Wiki-1].

4.1.3.1 Configuring qmake 

• Click on the Tools → Options from the top menubar.

• On the left side vertical menubar click Build & Run.

• Click the Qt Versions tab under Build & Run.

• Click Add... on the right.

• Navigate to /opt/ti-sdk-am335x-evm-06.00.00.00/linux-devkit/sysroots/i686-arago-linux/usr/bin.

• Select qmake then click on Open.

• Double click on Version Name and give the Qt Version a descriptive name such as “Qt 4.8.3 Sitara”.

• Click Apply to save your changes.

Figure 4.1-1:  Configuring qmake
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4.1.3.2 Configuring Compiler

• Click on the Tools → Options from the top menubar.

• On the left side vertical menubar click Build & Run.

• Click the Compilers tab under Build & Run.

• Click Add in the top right and add a GCC. 

• Change the name to arm-arago-GCC. This can be done by modifying the “Name” field.

• To set the Compiler Path select Browse. 

• Navigate to /opt/ti-sdk-am335x-evm-06.00.00.00/linux-devkit/sysroots/i686-arago-linux/usr/bin.

• Select arm-linux-gnueabihf-gcc and click on Open.

• Click Apply to save your changes.

Figure 4.1-2:  Configuring Compiler
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4.1.3.3 Configuring Debugger

• Click on the Tools → Options from the top menubar.

• On the left side vertical menubar click Build & Run.

• Click the Debugger tab under Build & Run.

• Click Add.

• Change the name to arm-arago-GDB. This can be done by modifying the “Name” field.

• To set the Debugger Path select Browse. 

• Navigate to /opt/ti-sdk-am335x-evm-06.00.00.00/linux-devkit/sysroots/i686-arago-linux/usr/bin.

• Select arm-linux-gnueabihf-gdb and click on Open.

• Click Apply to save your changes.

Figure 4.1-3:  Configuring Debugger
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4.1.3.4 Set-up Target

• Click on the Tools → Options from the top menubar.

• On the left side vertical menubar click Devices.

• Click Add... in the top right and select Generic Linux device and click on Start Wizard

• Change the name to AM335x EVM. This can be done by modifying the “Name” field.

• Type in the IP address of the embedded Linux device.

• Type in the password of the user.

• Type in the user (on the target) for SSH connection.

• Click Next and click Finish.

• Qt creator will attempt to connect to the embedded Linux device to check if correctly configured.

Figure 4.1-4:  Configuring Device
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4.1.3.5 Kit Configuration

• Click on the Tools → Options from the top menubar.

• On the left side vertical menubar click Build & Run.

• Click the Kits tab under Build & Run.

• Click Add.

• Change the name to Sitara Qt 4.8.3. This can be done by modifying the “Name” field.

• In the rest of the fields, select the previously configured components.

• To set the Sysroot Path select Browse. 

• Navigate to /opt/ti-sdk-am335x-evm-06.00.00.00/linux-devkit/sysroots/i686-arago-linux.

•  Click Choose.

• Click Apply to save your changes.

Figure 4.1-5:  Kit Configuration
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4.2. Target System

This section focuses on creating and configuring a bootable image for the target system such that
the target system is set-up and ready to be developed on.

The board used in this work is a Texas Instruments TMDSSK3358 AM335x Starter Kit. But the set-
up  and  configuration  described  in  this  section  is  valid  for  other  TI  systems  based around  the
AM335x processor family.

4.2.1 Creating SD Card Image

TI provides a straightforward script with which to create SD card images within the SDK. To create
a bootable SD card, insert a mini SD card of at least 2GB of capacity into a card reader on the host
computer and execute the following commands.

user@debian:~$ cd /opt/tisdkam335xevm06.00.00.00/bin/ 

user@debian:/opt/tisdkam335xevm06.00.00.00/bin$ ./create
sdcard.sh 

The script allows for various combinations, but the following options are suggested in this work
given set-up.

• Select SD card drive.

• Select the 2 partition scheme.

• Yes, continue.

• Install pre-built images from SDK

Finally, before removing the mini SD card, the following command should be executed to force
changed blocks to disk and update the super block.

user@debian:/opt/tisdkam335xevm06.00.00.00/bin$ sudo sync

4.2.2 Initial Configuration

Before powering up the device, it is necessary to insert the mini SD card and connect a network
cable to a router or switch on the same network as the host computer.

If using the AM335x Starter Kit, the network cable should be connected to the RJ45 jack farthest
from the female micro-USB jack. This, on the TI image created previously, is interface eth0, which
is  enabled  on  start-up.  The  other  RJ45 jack  is  interface  eth1,  which  is  neither  configured  nor
enabled on start-up and therefore is not useful at the moment.

Once boot-up is complete, the TI Matrix-GUI should be visible on screen.

4.2.2.1 Login

To check the IP address of the device tap on Settings →Network Settings. The IP address should
be listed under the eth0 interface section. For example, the IP address could be 192.168.1.33.
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Once the IP address of the device is  know, it  is  possible to start  a SSH session from the host
computer. By default, the root user does not have a password. When asked for the password, just hit
return to log on.

user@debian:~$ ssh 192.168.1.33 l root

root@192.168.1.33's password:

root@am335xevm:~#

For security reasons, it is advisable to set a password for the root user.

root@am335xevm:~# passwd

4.2.2.2 Disabling the Default Matrix-GUI Application

This section describes how to disable the TI Matrix-GUI from starting on boot if it is not needed or
undesired.

First it is necessary to determine which is the default runlevel, which varies among different Linux
distributions.

root@am335xevm:~# runlevel

The previous command returns the current runlevel, which is assumed to be the default on boot. In
this case, the default runlevel seems to be runlevel 5.

To  list  the  services  which  are  started  (or  stopped)  on  runlevel  5,  the  following  command  is
executed.

root@am335xevm:~# ls l /etc/rc5.d

From the previous command it is possible to determine that S97matrix-gui-2.0 starts the Matrix-
GUI service.

Finally, to disable the starting of this service on boot on the default runlevel.

root@am335xevm:~# cd /etc/rc5.d 

root@am335xevm:/etc/rc5.d# mv S97matrixgui2.0 K97matrixgui
2.0

4.2.2.3 Static IP Address

This section describes how to assign the device a static IP address to make is easily accessible and
identifiable over a network.

Before modifying the network interface configuration file, it is advisable to make a backup.

root@am335xevm:~# cp /etc/network/interfaces 
/etc/network/interfaces.bak

Now it is safe configure the network interfaces.

root@am335xevm:~# vi /etc/network/interfaces
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The section that configures the eth0 interface can be replaced with:

auto eth0                                                                    
iface eth0 inet static                                                       
    address 192.168.1.100                                                    
    gateway 192.168.1.1                                                      
    netmask 255.255.255.0                                                    
    network 192.168.1.0                                                      
    broadcast 192.168.1.255 

Note that with this configuration the device is assigned IP address 192.168.1.100.

4.2.2.4 Directory for Binaries

This section describes the creation of a  dedicated directory for third party binary files and the
inclusion of such directory in the binary search path.

The  following  command  is  executed  to  create  the  directory  /usr/local/bin,  into  which  user
developed applications shall be copied.

root@am335xevm:~# mkdir p /usr/local/bin

To add this directory automatically to the $PATH variable at login if the directory exist, a profile file
is created.

root@am335xevm:~# vi ~/.profile

The content of the file being:

#f [ -f ~/.bashrc ]; then
# . ~/.bashrc
#fi

# set PATH so it includes third party bin if it exists
if [ -d "/usr/local/bin" ] ; then
    PATH="$PATH:/usr/local/bin"
fi

#mesg n

4.2.2.5 USB-to-Serial Adapter Support

Please,  note  that  this  section  is  included  for  the  TMDSSK3358  AM335x  Starter  Kit.  The
BeagleBone Black comes with support for USB-to-serial adapters out-of-the-box.

The application to be developed shall communicate with an industrial scale that offers an RS-232
output with a USB-to-serial adapter. However, the kernel currently installed on the target system
does not have the drivers for these devices. It is necessary to compile a kernel with USB-to-serial
adapter support.

There are many adapters on the market with different chips. In this project, the Prolific PL2303 chip
is used as it is the integrated circuit used inside the USB-to-serial adapter used in the development
of  this  project.  Therefore,  this  section  is  centred  around obtaining  support  for  this  device,  but
similar steps must be taken with other devices.

The  following  section  is  a  commented  extract,  with  slight  modifications  of  part  of  the  Texas
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Instruments Document: AMSDK Linux User's Guide, [TI-Wiki-2].

In order to build the Linux kernel you will need a cross compiler installed on your system which
can generate object code for the ARM core in your Sitara device. To add the compiler to the path,
the following command is executed.

user@debian:~$ export PATH="/opt/tisdkam335xevm
06.00.00.00/linuxdevkit/sysroots/i686aragolinux/usr/bin:
$PATH"

user@debian:~$ cd /opt/tisdkam335xevm06.00.00.00/board
support/linux3.2.0psp04.06.00.11

Prior to compiling the Linux kernel it is often a good idea to make sure that the kernel sources are
clean and that there are no remnants left over from a previous build.  The command to clean the
kernel is: 

user@debian:~$ make ARCH=arm CROSS_COMPILE=armlinuxgnueabihf 
mrproper

Before compiling the Linux kernel it needs to be configured to select what components will become
part  of  the  kernel  image,  which  components  will  be  build  as  dynamic  modules,  and  which
components will be left out all together. This is done using the Linux kernel configuration system. 

It is often easiest to start with a base default configuration and then customize it for you use case if
needed. In the Linux kernel a command of the form:

user@debian:/opt/tisdkam335xevm06.00.00.00/board
support/linux3.2.0psp04.06.00.11$ make ARCH=arm 
CROSS_COMPILE=armlinuxgnueabihf tisdk_am335xevm_defconfig 

After the configuration step has run the full configuration file is saved to the root of the kernel tree
as .config. Any further configuration changes are based on this file until it is clean-up up by doing a
kernel clean as mentioned above.

Now,  the  only  modification  that  need  to  be  done  to  the  configuration  file  is  to  set  the
CONFIG_USB_SERIAL option.

user@debian:/opt/tisdkam335xevm06.00.00.00/board
support/linux3.2.0psp04.06.00.11$ sed i 's/# 
CONFIG_USB_SERIAL is not set/CONFIG_USB_SERIAL=y/g' .config 

To compile the kernel, the following command is executed.

user@debian:/opt/tisdkam335xevm06.00.00.00/board
support/linux3.2.0psp04.06.00.11$ make ARCH=arm 
CROSS_COMPILE=armlinuxgnueabihf uImage 

At this point, before the compilation begins, as the USB-to-serial flag was set, the make executable
will ask whether or not to enable support for a variety of devices. For the purpose of this project,
only the USB_SERIAL_PL2303 is enabled.

Finally it is necessary to install the kernel. Installation is done by moving the kernel image to the
location where it is read on the target system. With the following sequence, a backup of the current
kernel is made, the new kernel is transferred over to the target system and the target system is then
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rebooted.

root@am335xevm:~# cp /media/mmcblk0p1/uImage 
/media/mmcblk0p1/uImage.bak 

user@debian:/opt/tisdkam335xevm06.00.00.00/board
support/linux3.2.0psp04.06.00.11$ scp arch/arm/boot/uImage 
root@192.168.1.100:/media/mmcblk0p1/uImage 

root@am335xevm:/boot# shutdown r now 

If everything has gone well, the system will come up as normal.

To check if the new kernel is running, the following command can be executed. The date in the
output of the command is the compilation date of the kernel that is currently running.

root@am335xevm:~# uname a 

At this point, if the USB-to-serial adapter is connected then the following command is executed, the
output of the command should inform that the adapter is now attached to ttyUSBx, where “x” is an
integer.

root@am335xevm:~# dmesg 

4.2.2.6 Touchscreen Calibration and Test

TI provides utilities to calibrate and test the touchscreen with the system image.

root@am335xevm:~# ts_calibrate 

root@am335xevm:~# ts_test

The ts_calibrate command prints the screen resolution. This will be useful to create applications of
exactly the screen size. In this case, the touchscreen has a resolution 480×272 pixels.

4.3. Application Template

To create a basic project for the target system, the following steps have been followed.:

• Click on the File → New File or Project from the top menubar.

• At the Top right corner select Embedded Linux Template.

• Then select QT Widget Application from the centre list.

• Click on Choose.

• Name the project Template-Sitara.

• Click Next. 

• Select the previously configured Sitara Kit. 

• Click Next. 

• In the Class Information window, select QWidget Base Class. 
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• Click Next. 

• Leave version control to <none>. 

• Click Finish.

With the project created, only some minor configuration remains to be done.

The size of the widget should match the screen size of the device. To do this, inside the UI editor,
using the property editor, edit the following: 

QWidget→Geometry→Width→480 and QWidget→Geometry→Height→272.

For testing purposes, a label with the text “Hello World!” was added to the widget.

As the Matrix-GUI may not be running, the application cannot connect to a running virtual frame
buffer and the Qt embedded Linux applications must start one if this is the case. On the left side of
the window, click on the Projects tab than select the Run&Build tab and finally the Run tab. In the
Arguments field, “-qws” must be added.

Figure 4.3-1:  Application Arguments

Finally, the following lines should be added to the project file to Specify that the binaries should be
copied over to the directory /usr/local/bin on the target.

target.path += /usr/local/bin
INSTALLS += target

The template is now ready to be build, deployed and debugged.
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Figure 4.3-2: Test Application
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5. Detailed Description of the Adopted Solution
5.1. Application

In this section, a detailed description of the adopted solution for the application to be developed
shall be exposed.

5.1.1 External Relations

Following is a schematic diagram representing the input and output of data between the application
and the different hardware, files and interfaces with which it must interact.

Figure 5.1-1: Application Interface

From the diagram above and with and general idea of how the application must interact with the
different devices, files and interfaces, it is possible to determine that the following errors might be
encountered during execution time:

• Argument error: failed to parse command line argument. An invalid command line argument was passed.

• Database error: failed to open/close database. The specified database could not be found. 

• Query error: query failed to execute successfully. Query is malformed or database is corrupt.

• Serial error: serial connection could not be established. Specified serial port could not be opened. 

• Scale error: scale is sending unexpected values. Scale Calibration needed.

It is possible to distinguish that “argument error” and “database error” are “malignant errors” and if
encountered at  run time, the application should close immediately and output an error message
through standard error.
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• Database error is a malignant error because the application should never start if the database file cannot
be found, as no product information could be read or written. This would render the application useless as
no transaction could be performed successfully.

• Argument error is a malignant error because the application should not start if an argument could not be
interpreted.  Otherwise,  the  user  might  be  under  the  impression  that  the  application  is  executing  as
specified through the command line interface, when in reality the invalid arguments are ignored.

On the other hand, “query error”, “serial error” and “scale error” are “benign errors” because if
encountered during execution time, the error could be corrected without stopping the application.
For these errors, a warning windows shall open here the user shall need to acknowledged the error
before having the application can continue to execute.

If these errors are encountered, however, the application shall restrict the operations the user can
perform with regard the affected modules or subsystems. For example: if USB-to-serial converter is
not connected to the system, when the application attempts to open the port, the warning window
shall  be displayed, but even if  the warning is  acknowledged,  the user shall  not be allowed to
register a sale.

Finally, to simplify the processing of these five errors, an enumerated data type and an a class shall
be defined.

The enumerated data type, called errorCode, shall contain the five errors and a “success”. This data
type shall be used as a return type to some functions to signal if they were executed without error or
if an error occurred.

The benign error acknowledgement window shall be implemented in a class and the set-up function
shall  take  as  input  an  errorCode  enumerated  data  type.  Depending  on  the  value  of  the  input,
different messages shall be displayed on-screen.

5.1.2 Application Structure

The structure of the application in terms of the classes that compose it is described in the diagram
below. Note that the diagram only represents the classes that where created for this project and not
the classes that C++ or any other third party entities provide.

Figure 5.1-2: Application Structure
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● main: The main function is not a class. It is the top level function whose purpose is to initiate
application wide parameters, create and execute a MainWindow class and restart the application if
MainWindow returns from execution a restart code. The main function starts the whole 

● MainWindow: This class encapsulates the methods and variables necessary to display the main
product selection window. MainWindows is main UI. It displays buttons with the icon, ID number
and name of  the  products,  in  groups of  6,  and the  buttons  necessary to  navigate  forward  and
backwards through the product list. It also provides buttons to execute the advanced options dialog
and the accumulated sales dialog. 

●  tableDialog:  This  class  encapsulates  the  methods  and  variables  necessary  to  display  the
accumulated sales of all products in the database. The tableDialog class displays a scrollable table
with all the products on the database and the current accumulated sales in the predefined mass unit
(kg by default). From this class it is also possible to clear all the accumulated sales. 

●  Database: This class encapsulates the methods and variables necessary to manage the SQLite
database. The Database class provides high-level, specialized functions that are needed to operate
with the product database (open, close, read and write). 

● Command: This class encapsulates the methods and variables necessary to parse the command
line arguments that are supported. The Command class parses an array of command line arguments
and updates parameters accordingly. 

●  optionsDialog:  This  class  encapsulates  the  methods  and  variables  necessary  to  display  and
execute  configuration  options.  The options  supported  are:  application  restart,  application  close,
system restart and system shutdown. The optionsDialog class also provides the button to execute
the aboutDialog. 

● aboutDialog: This class displays "about" information of the application. The information is static
and  defined  in  the  UI  file.  The  aboutDialog  class  also  provides  the  button  to  execute  the
licenseDialog. 

● licenseDialog: This class displays the license information of the application. The information is
static and defined in the UI file. 

● productDialog: This class encapsulates the methods and variables necessary to display product
weight and information.  Once selected the product,  the data stream from the industrial  scale is
processed to read the weight and a product dialog is displayed with all the product information and
the monetary value of the product being weighted. 

● messageDialog: This class encapsulates the methods and variables necessary to display error and
information messages. If a benign error is encountered,  this dialog warns the user and asks for
acknowledgement before continuing. 

●  serialScale:  This  class  encapsulates  the  methods  and  variables  necessary  to  manage  the
communication with the industrial scale. The serialScale class manages the serial communication
between the industrial scale and the application. Communication is carried put over RS-232. The
string  processing  carried  out  in  this  class  is  intended  to  work  with  the  Microgram ie21  from
Microgram Instruments  Española,  S.A.  String  processing  functions  must  be  modified  if  other
hardware is to be used. 

● productStruct: Product data structure. This data structure encapsulated variables to be used in
the productDialog class.
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5.1.3 Application Flowcharts

To better explain how the application functions, a flowchart and a screenshot for each dialog and
the Main function is described in this section.

It should be noted that not all the source code shall be reflected in this section as there are modules
such as database module, serial module or command module which provide important functions for
the  correct  execution  of  the  application  but  can  not  be  described  in  terms  of  a  flowchart  by
themselves. There are also header files such as errorcode.h and productstruct.h whose only purpose
is to provide the implementation of an enumerated and structured data types respectively.

5.1.3.1 Main

The main function is composed solely of the C++ source code file main.cpp.

The flow diagram for this module is as follows:

Figure 5.1-3: main Flowchart
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5.1.3.2 Main Window

The MainWindow module is composed of the C++ source code file mainwindow.cpp, the C header
file mainwindow.h and the Qt form mainwindow.ui.

The flow diagram for this module is as follows:

Figure 5.1-4: MainWindow Flowchart
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The Qt form mainwindow.ui provides the GUI for this module, a screenshot of which is provided
below.

Figure 5.1-5: MainWindow UI
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5.1.3.3 Product Dialog

The productDialog  module  is  composed of  the  C++ source  code file  productdialog.cpp,  the  C
header file productdialog.h and the Qt form productdialog.ui.

The flow diagram for this module is as follows:

Figure 5.1-6: productDialog Flowchart
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The Qt form productdialog.ui provides the GUI for this module, a screenshot of which is provided
below.

Figure 5.1-7: productDialog UI
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5.1.3.4 Message Dialog

The messageDialog module is composed of the C++ source code file messagedialog.cpp, the C
header file messagedialog.h and the Qt form messagedialog.ui.

The flow diagram for this module is as follows:

Figure 5.1-8: messageDialog Flowchart
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The Qt form messagedialog.ui provides the GUI for this module, a screenshot of which is provided
below. Note that this screenshot is warning of a serial communication error, but other errors are also
reported.

Figure 5.1-9: messageDialog UI

38 1 - Report



QT SET-UP FOR TEXAS INSTRUMENTS AM335X ARM CORTEX-A8 USING LINUX:

APPLICATION FOR AN INDUSTRIAL SCALE

5.1.3.5 Table Dialog

The tableDialog module is composed of the C++ source code file tabledialog.cpp, the C header file
tabledialog.h and the Qt form tabledialog.ui.

The flow diagram for this module is as follows:

Figure 5.1-10: tableDialog Flowchart

The Qt form tabledialog.ui provides the GUI for this module, a screenshot of which is provided
below.

Figure 5.1-11: tableDialog UI
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5.1.3.6 Options Dialog

The optionsDialog module is composed of the C++ source code file optionsdialog.cpp, the C header
file optionsdialog.h and the Qt form optionsdialog.ui.

The flow diagram for this module is as follows:

Figure 5.1-12: optionsDialog Flowchart

The Qt form optionsdialog.ui provides the GUI for this module, a screenshot of which is provided
below.

Figure 5.1-13: optionsDialog UI
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5.1.3.7 About Dialog

The aboutDialog module is composed of the C++ source code file aboutdialog.cpp, the C header
file aboutdialog.h and the Qt form aboutdialog.ui.

The flow diagram for this module is as follows:

Figure 5.1-14: aboutDialog Flowchart

The Qt form aboutdialog.ui provides the GUI for this module, a screenshot of which is provided
below.

Figure 5.1-15: aboutDialog UI
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5.1.3.8 License Dialog

The licenseDialog module is composed of the C++ source code file licensedialog.cpp, the C header
file licensedialog.h and the Qt form licensedialog.ui.

The flow diagram for this module is as follows:

Figure 5.1-16: licenseDialog Flowchart

The Qt form licensedialog.ui provides the GUI for this module, a screenshot of which is provided
below.

Figure 5.1-17: licenseDialog UI
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5.1.4 Text Fonts for Internationalization

Taking into account the current level of globalization, which is expected to increase even more in
the coming years, the application being developed should have internationalization support. As one
of the goals of this project is to create a portable multi-platform  (OS and architecture) application,
internationalization can be seen as an extension of portability: it  will give the application to be
executed not only across a variety of operations systems and architectures, but also in a variety of
languages and locales.

Qt has  good support  for application internationalization built-in,  but  in  order to  represent  non-
ASCII characters on-screen, the appropriate fonts must be present on the target system. The target
system by default only comes with fonts for the English language.

This  section details  the process of  adding fonts for  the correct  representation of  alphabets  and
writing systems of languages other than the default for the target system. Specifically,  Japanese
fonts shall be added but the process can be extrapolated for other fonts.

First of all, it is necessary to download the TrueType files for the desired fonts. The latest Takao
Japanese font family shall be downloaded, as it is a free and open source TrueType font as it is
suitable  for  both  display  and  printing  and  it  is  a  popular  font  on  the  Debian  and  Ubuntu
distributions.

user@debian:~$ cd Downloads/ 

user@debian:~/Downloads$ wget https://launchpad.net/takao
fonts/003.02/003.02.01/+download/takaofontsttf
003.02.01.tar.gz 

user@debian:~/Downloads$ tar zxvf takaofontsttf
003.02.01.tar.gz 

user@debian:~/Downloads$ cd takaofontsttf003.02.01/

Now the fonts shall be transferred over to the target system.

user@debian:~/Downloads/takaofontsttf003.02.01$ scp *.ttf 
root@192.168.1.100:/usr/lib/fonts/

With this, the target system now has support for representing Japanese text.

Finally, some clean-up is required on the host computer.

user@debian:~/Downloads/takaofontsttf003.02.01$ cd .. 

user@debian:~/Downloads$ rm rf takaofontsttf003.02.01 

user@debian:~/Downloads$ rm takaofontsttf003.02.01.tar.gz 
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Figure 5.1-18: Application Using Japanese Database

5.1.5 Application Start on Boot

One of the requirements is that the application must start on system boot or restart by default. The
starting and stopping of programs and services on Unix and Unix-like systems is handled by the Init
Scripts. [Debian-wiki] is taken as reference to create a Linux Standard Base (LSB) Init script to
start  the  application  being  developed  on all  runlevels  except  shutdown,  reboot  and single-user
mode. By making the script LSB compliant it makes it portable across many Unix and Unix-like
distributions.

First, it is necessary to create the script on the target system.

root@am335xevm:~# vi /etc/init.d/QtSerialinit.sh

The content of the script being:

#! /bin/sh
# /etc/init.d/QtScale-init.sh

### BEGIN INIT INFO
# Provides:          QtScale
# Required-Start:    $local_fs $syslog
# Required-Stop:     $local_fs $syslog
# Default-Start:     2 3 4 5
# Default-Stop:      0 1 6
# Short-Description: Start QtScale at boot time.
# Description:       Start QtScale with "-qws" option
### END INIT INFO

case "$1" in
  start)
echo "Starting QtScale"

    /usr/local/bin/QtScale -qws --path=/home/root/.QtScale/
    ;;
  stop)
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    echo "Stopping QtScale"
    killall QtScale
    ;;
  *)
    echo "Usage: /etc/init.d/QtScale-init.sh {start|stop}"
    exit 1
    ;;
esac

exit 0

This would be a generic script. But as the application is being developed on the Texas Instruments
TMDSSK3358 AM335x Starter Kit,  further processing is required for the application to behave
correctly: the touchscreen pointer needs to be configured. Taking as reference /etc/init.d/matrix-gui-
2.0 Which is the Matrix-GUI application initialization script, the following changed are made to the
basic script.

#! /bin/sh
# /etc/init.d/QtScale-init.sh

### BEGIN INIT INFO
# Provides:          QtScale
# Required-Start:    $local_fs $syslog
# Required-Stop:     $local_fs $syslog
# Default-Start:     2 3 4 5
# Default-Stop:      0 1 6
# Short-Description: Start QtScale at boot time.
# Description:       Start QtScale with "-qws" option
### END INIT INFO

export TSLIB_TSDEVICE=/dev/input/touchscreen0
export QWS_MOUSE_PROTO=Auto
tsfile=/etc/pointercal

case "$1" in
  start)
    # ARM9 devices get a lot of alignment trap errors with the current
    # version of Qt (4.7.2) that we use.  The printing of these messages
    # is causing a severe slowdown with QtScale and other Qt applications
    # that QtScale launches.  The root cause is under investigation and an
    # issue is being filed in the Qt JIRA tracker.  For now using the
    # following command will do a software fixup of the alignment trap errors
    # in the kernel.  This should have no impact on cortex-A8 devices.
    echo 2 > /proc/cpu/alignment

    # Do not try to calibrate the touchscreen if it doesn't exist.
    if [ -e /dev/input/touchscreen0 ]
    then
        export QWS_MOUSE_PROTO=Tslib:/dev/input/touchscreen0
        # Check if the SD card is mounted and the first partition is
        # vfat.  If so let's write the pointercal file there so that if
        # someone messes up calibration they can just delete the file from
        # any system and reboot the board.
        mount | grep /media/mmcblk0p1 | grep vfat > /dev/null 2>&1
        if [ "$?" = "0" ]
        then
            tsfile=/media/mmcblk0p1/pointercal
            export TSLIB_CALIBFILE=$tsfile
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        fi

        if [ ! -f $tsfile ] ; then
            echo -n "Calibrating touchscreen (first time only)"
            ts_calibrate
            echo "."
            # If we create a pointercal file and 
            # it was not in /etc/pointercal
            # let's copy it there as well if it does not already exist.
            if [ ! -f /etc/pointercal -a -f $tsfile ]
            then
                cp $tsfile /etc/pointercal
            fi
        fi
    fi

    echo "Starting QtScale"
    /usr/local/bin/QtScale -qws --path=/home/root/.QtScale/
    ;;
  stop)
    echo "Stopping QtScale"
    killall QtScale
    ;;
  *)
    echo "Usage: /etc/init.d/QtScale-init.sh {start|stop}"
    exit 1
    ;;
esac

exit 0 

After saving and exiting vi, the script must be made executable.

root@am335xevm:~# chmod 755 /etc/init.d/QtScaleinit.sh

To register the script, the following command is executed. Note that the “99” is to try to set-back
the execution of the script as much as possible during boot.

root@am335xevm:~# updaterc.d QtScaleinit.sh defaults 99

Now the application will start automatically on boot. If for some reason it is necessary to stop the
script from executing, the following command should be executed.

root@am335xevm:~# updaterc.d f QtScaleinit.sh remove 
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5.2. SQLite Database

5.2.1 Database Design

The specifications demand for a database that has at least the following fields: image, name, index,
price  and  accumulated  sales.  This  information  that  the  client  has  provided  narrows  down  the
adopted solution for the database design, but nevertheless, it is good practice to follow the standard
design progress.

Determine the Purpose of the Database

The database is to be used as a local, single-file database for an embedded application when it is not
expected to have more than one instance reading and/or writing in the database file. The database is
intended to store product information and accumulated sales values.

Find and Organize the Information Required

As stated earlier, the data to be stored in the database has already been defined, but not the data
type. In this section, each data point will be given a data type according to the nature of the data.

Data Index Name Image Price Accumulated

Data type Integer Text Blob Real Real

Divide the Information into Tables

At this point is is possible to extract that in this database, there is only one entity: “Product”. All
that data that need to be included in the database are attributes of the “Product” entity (index, name,
image, price and accumulated sales).  Therefore,  only one table is necessary in this  database.  It
should be noted that this refers to the tables that arise from entity and entity relationships, more
tables might be necessary when normalizing the database.

Turn Information Items into Columns

As there is only one entity and one table, all the attributed of the entity become columns in the
table. In other words: the database has one table called “Products” with 5 columns named “Index”,
“Name”, “Image”, “Price” and “Accumulated”.

Specify Primary Keys

Each table must have a primary key. The Product table's primary key is the index, as one might
assume from the name. It is the primary key because the index is a unique integer that identified
each product.
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Set-up the Table Relationships

As there is only one table, there are no relationships between tables. The data stored in the Product
table is unique and different for each product. This implies that the entity and all its attributes have
one-to-one relationship.  Please note that even though the price or accumulated sales of various
entities can be the same at a given point, there is no point in creating a relationship from these
attributes and separate tables (one-to-many relationship).

Refine the Design

No further refinement or simplifications can be made the database.

Apply the normalization rules

The designed database is so limited and simple that it does not require normalization as every cell
contains a single value (atomic), every non-key column is fully dependent on the primary key and
non-key columns are of each other. Another way to see this is that the database is so simple that it is
already normalized to third form normalization (at least). The database is both OLTP (transactional)
and OLAP (analytical) at the same time, or neither, depending how it is viewed.

In any case, the designed database can not be refined, simplified or normalized any further with the
current specifications, and therefore it is taken as the adopted solution.

Figure 5.2-1: Database Schema

5.2.2 Database Creation

This section describes the process of creating the previously designed database. As an example, a
database that contains 9 fruits (products) shall be created with the following data.

Index Name Image Price Accumulated

5 Strawberry (PNG blob) 2.50 0.0

10 Pear (PNG blob) 1.30 0.0

12 Peach (PNG blob) 1.00 0.0

13 Orange (PNG blob) 0.70 0.0

15 Lemon (PNG blob) 1.75 0.0
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22 Grape (PNG blob) 3.90 0.0

23 Cherry (PNG blob) 3.70 0.0

25 Banana (PNG blob) 1.40 0.0

37 Apple (PNG blob) 1.60 0.0

The first step is to create the database file with the Product table that has been previously designed.
The database shall be named QtScale.sqlite.

user@debian:~$ sqlite3 QtScale.sqlite "CREATE TABLE Products(ID 
integer primary key,Name text,Icon blob,Price real,Accumulated
real);"

Now it is possible to insert the data. One command is required for every product record, therefore 9
commands must be executed. The images are inserted as a blob by doing a hexadecimal dump. This
method has been proven to work with the Qt SQL module as images can be retrieved correctly.

user@debian:~$ echo "INSERT INTO 
Products(ID,Name,Icon,Price,Accumulated) 
values(5,'Strawberry',X'`hexdump ve '1/1 "%.2x"' 
Icons/Strawberry.png`',2.50,0.0);" | sqlite3 QtScale.sqlite

user@debian:~$ echo "INSERT INTO 
Products(ID,Name,Icon,Price,Accumulated) 
values(10,'Pear',X'`hexdump ve '1/1 "%.2x"' 
Icons/Pear.png`',1.30,0.0);" | sqlite3 QtScale.sqlite 

user@debian:~$ echo "INSERT INTO 
Products(ID,Name,Icon,Price,Accumulated) 
values(12,'Peach',X'`hexdump ve '1/1 "%.2x"' 
Icons/Peach.png`',1.05,0.0);" | sqlite3 QtScale.sqlite 

user@debian:~$ echo "INSERT INTO 
Products(ID,Name,Icon,Price,Accumulated) 
values(13,'Orange',X'`hexdump ve '1/1 "%.2x"' 
Icons/Orange.png`',0.70,0.0);" | sqlite3 QtScale.sqlite 

user@debian:~$ echo "INSERT INTO 
Products(ID,Name,Icon,Price,Accumulated) 
values(15,'Lemon',X'`hexdump ve '1/1 "%.2x"' 
Icons/Lemon.png`',1.75,0.0);" | sqlite3 QtScale.sqlite 

user@debian:~$ echo "INSERT INTO 
Products(ID,Name,Icon,Price,Accumulated) 
values(22,'Grape',X'`hexdump ve '1/1 "%.2x"' 
Icons/Grape.png`',3.95,0.0);" | sqlite3 QtScale.sqlite 

user@debian:~$ echo "INSERT INTO 
Products(ID,Name,Icon,Price,Accumulated) 
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values(23,'Cherry',X'`hexdump ve '1/1 "%.2x"' 
Icons/Cherry.png`',3.70,0.0);" | sqlite3 QtScale.sqlite 

user@debian:~$ echo "INSERT INTO 
Products(ID,Name,Icon,Price,Accumulated) 
values(25,'Banana',X'`hexdump ve '1/1 "%.2x"' 
Icons/Banana.png`',1.40,0.0);" | sqlite3 QtScale.sqlite 

user@debian:~$ echo "INSERT INTO 
Products(ID,Name,Icon,Price,Accumulated) 
values(37,'Apple',X'`hexdump ve '1/1 "%.2x"' 
Icons/Apple.png`',1.60,0.0);" | sqlite3 QtScale.sqlite

With this, the database has been created and all the data has been inserted. This database would be a
valid database ready to be used by the application to be developed.

Please note that this method assumes that there is a subdirectory in the current working directory
called “Icons” that contains a PNG image for every product that has the same name as the product it
represents followed by a “.png” extension. For a clearer explanation, the content of the subdirectory
for this example is as follows.

user@debian:~$ ls Icons/ 

  Apple.png  Banana.png  Cherry.png  Grape.png  Lemon.png  
Orange.png  Peach.png  Pear.png  Strawberry.png 

5.2.3 Database Management

For the management of the database, various options are available but for simplicity of use a GUI
application is recommended. A popular standalone, open source, cross-platform GUI application for
this  purpose  is  “SQLite  Database  Browser”.  SQLite  Database  Browser  can  be  obtained  from
<http://sourceforge.net/projects/sqlitebrowser/>. However, there are many other applications1 that
will perform the required task successfully.

This application is intuitive and easy to use even for novice users and it  allows to browse and
modify databases without SQL queries. Although it does support SQL query input for the users who
prefer it.

Please note that this section refers to the management and updating of existing database records.
New records are recommended to be inserted with the aforementioned method as it is the only one
where the image insertion has been tested to work successfully.

1 Another popular application to manage SQLite databases come in the form of a Firefox add-on with very similar 
functionality and UI as the aforementioned application. The add-on can be obtained from 
<https://addons.mozilla.org/en-US/firefox/addon/sqlite-manager/>
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Figure 5.2-2: SQLite Database Browser

5.3. QtSerialPort

QtSerialPort  was introduced as  an  internal  module in  Qt 5 as  the  substitute  of  QextSerialPort.
QtSerialPort is now the default module in Qt to handle serial connections and it is being developed
by the same team that worked on QextSerialPort. The QextSerialPort project has been abandoned. 

In this project, Qt 4.8 libraries are being used as this is what is supplied in the Texas instruments
SDK but it is worth noting that the QtSerialPort source code supports Qt 4, which means that the
module can be configured, compiled and used in Qt 4.

QtSerialPort shall be used in this project as it is officially supported by Qt, no external third party
library is required, it  is more feature rich than QextSerialPort and, most importantly, because it
eases cross-platform compatibility and compatibility with current and future Qt releases.

This section details the process of adding the QtSerialPort module to the current set-up such that it
can be used in the application being developed. The detailed process is based on the instructions
given in [Qt-Wiki].

First, it is necessary to download the source code in the TI SDK directory and set up the build
environment.

user@debian:~$ source /opt/tisdkam335xevm06.00.00.00/linux
devkit/environmentsetup 

[linuxdevkit]:~> cd /opt/tisdkam335xevm06.00.00.00/ 
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[linuxdevkit]:/opt/tisdkam335xevm06.00.00.00> git clone 
git://gitorious.org/qt/qtserialport.git 

[linuxdevkit]:/opt/tisdkam335xevm06.00.00.00> mv 
qtserialport/ qtserialportsrc/ 

[linuxdevkit]:/opt/tisdkam335xevm06.00.00.00> mkdir 
qtserialportbuild 

[linuxdevkit]:/opt/tisdkam335xevm06.00.00.00> cd 
qtserialportbuild/

Now it is possible to proceed and compile and install the shared library.

[linuxdevkit]:/opt/tisdkam335xevm06.00.00.00/qtserialport
build> qmake ../qtserialportsrc/qtserialport.pro 

[linuxdevkit]:/opt/tisdkam335xevm06.00.00.00/qtserialport
build> make 

[linuxdevkit]:/opt/tisdkam335xevm06.00.00.00/qtserialport
build> make install

Now the library is present within the TI SDK but it has to be transferred to the target system.

[linuxdevkit]:/opt/tisdkam335xevm06.00.00.00/qtserialport
build> scp src/serialport/libQtSerialPortE.so.1.0.0 
root@192.168.1.100:/usr/lib/

Finally, some symbolic links must be created on the target system so that applications can resolve
the dynamic library dependency correctly.

root@am335xevm:~# ln s /usr/lib/libQtSerialPortE.so.1.0.0 
/usr/lib/libQtSerialPortE.so      

root@am335xevm:~# ln s /usr/lib/libQtSerialPortE.so.1.0.0 
/usr/lib/libQtSerialPortE.so.1 

root@am335xevm:~# ln s /usr/lib/libQtSerialPortE.so.1.0.0 
/usr/lib/libQtSerialPortE.so.1.0

Now it  is  possible  to  compile  binaries  that  depend on  QtSerialPort  on  the  host  computer  and
executed on the target system.

To use QtSerialPort in a Qt 4 project, the following lines must be added to the project file.

CONFIG += serialport

To use QtSerialPort in a Qt 5 project, the following lines must be added to the project file.

QT += serialport

And the following lines must be added to the source code files that use functions, structures or
classes from QtSerialPort.

#include <QtSerialPort/QSerialPort>
#include <QtSerialPort/QserialPortInfo>
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6. Conclusions and Future Work
Taking into account that in recent years there has been an increase in the number of devices that use
an ARM Cortex-A processor, because they are a cost-effective and power efficient solution for
applications  where  the  task  to  be  performed  is  not  CPU intensive  and  that  their  performance
continues to improve year by year. It is possible to conclude that an increase in the number of
industrial computers running on ARM processors with embedded Linux will be seen in the coming
years due to its advantages for low power applications.

This  project  highlights  that  with  the Qt C++ framework it  is  possible  to  easily develop cross-
platform applications  in  C++  for  embedded  Linux  that  can  be  ported  to  industrial  computers
running on more traditional x86 processors. This fulfils part of the project requirements, which were
to have this report serve as reference as a general reference for developing industrial applications
for the TI AM335x processor family running embedded Linux. Having a wider range of hardware
options is always an advantage.

In  the  developing  of  the  application  for  the  industrial  scale,  a  greater  understanding  of  SQL
databases  and  industrial  communications  has  been  attained  as  well  as  the  deepening  of  the
knowledge  of  embedded  Linux  systems.  The  project,  as  a  whole,  has  also  served  as  valuable
experience in the development of industrial projects in the fields of industrial computer science and
industrial electronics.

Overall, it is possible to conclude that all the requirements and objectives set at the start of the
project have been fulfilled and valuable academic and professional experience has been acquired in
the process of developing 

Going beyond the specification of the project, 3 upgrades are proposed as future work that would
improve the flexibility, functionality and robustness of the application:

• Add printing functionality to the system such that when a sale is complete, a ticket is
printed with information such as: the name of the product, the weight of the product, the
total price, the date and time of the transaction and a bar code (and or QR code) to be later
scanned by the cashier.  This upgrade provides greater  functionality to  the project  but  it
would be challenging to configure, compile and set up CUPS on the target system. Making
this feature cross-platform might also be an issue.

• Upgrade to the database (and the application) and add an attribute to the product entity
which  would  indicate  if  the  product  is  in  stock.  This  could  simplify  the  database
entertainment as the product record would not have to be removed when the product is out
of  stock  to  then  be  reinserted  when  it  is  back  in  stock.  This  would  translate  to  less
maintenance required to be done through the command line.

• User defined serial port during execution time instead of having it defined at compile time.
The user should be able to select which serial port to use through a command line interface
or an option window. In practice, the solution that would make more sense it to have only a
command line interface for this function as it is an advanced setting that the average user
should not need to be concerned with. A command line argument option, similar to the one
implemented to specify the database location, could be implemented to set the serial port at
the application start. Much like the database location option, this serial port option would
have a default value (/dev/ttyUSB0) in case the user does not explicitly pass the argument.
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